Chapter 5

Working with Employee Accident

Reports

You can search, view, add, edit, and delete accident reports. You can also generate and print accident

reports as well as view individual and group accident reports on a map. In this chapter, the following topics

should help maintain your district’s accidents:

e  Using the Accident Report Search Screen

e Combining the Accident Search Options with Employee Search Options
e  Working with an Individual Employee’s Accident Reports

e Adding Accidents
e Editing Accidents

e  Generating and Printing Accident Reports

e Viewing Accident Reports on a Map using Microsoft MapPoint

e Deleting Accidents

Using the Accident Report Search Screen

The Accidents Search Screen has many searching options that are organized into three search tabs (see

Figure 5-2):

e  General Subtab
e  Details and Contributing Factors Subtab
e  User/Custom Subtab

5 Search Employees
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Figure 5-1. Accident subtabs
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To search employee accident reports:

1. Click on the Accidents tab in you Employee Management search screen (Figure 5-2).
5. Search Employees g@
File Security Maintain Window Help
= [ Friday, September 03, 2004
BN T.0.M. Employee Management
(=] Employees} B Remindersl 4z Training I 7% Absences () Accidents \
Accident # Vehicle # i
Addr/Location: ‘ ¥ Search Entire Accident Type: A
Accident Dt between | j and ‘ j Time between: @ and ﬁ
General | Detals & Contrbuting Factors | User/Custom |
Date ‘ Time | Type | Location Vehicle Emp# | Name
Click here
to reset the
System. \ 1< [} >
\Shawnn Map ‘
Find Nc!w\ Reset ‘ Group Training | Group Reminder Print Exit

Figure 5-2. Tabs on the Accident screen

2. Click the Reset button to start with a fresh search.

3.

Enter the desired search criteria using the three subtabs (see detailed discussion of each subtab below)

or enter no search criteria to retrieve all employee accident reports.

4.

Figure 5-3 shows a search of accident reports that occurred between
August 31, 2004:

Click the Find Now button. (See Figure 5-3 for an example of accident search results).

September 1, 2003, and
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5 Search Employees E]@
File  Security Maintain  Window Help
= - Friday, September 03, 2004
BT T.0.M. Employee Management
=] Employees} [ Remmders] &y Trammg] T Absences &) Accidents l 2 Record(s) Found
Accident # Vehicle # =
Addr/Location: | I Search Entire Accident Type =
Accident Dt between: |9."1."2883 jand |8_."31_."2GG4 j Time between: | @ and | @

General | Details & Contributing Factors I User/Custom J

Date | Time | Type | Location Vehicle |Emp# | Name
9/25/2003 4.00PM  COLL_VEH 5120W.MERCER LN, GLENDALE AZ 0042 123 HINDIY
1/8/2004  235PM  COLL_BIKE 32nd ST & GREENWAY RD, PHOENI.. 1892 338 SMITH,

Show on Map
Find Now Reset | Group Training ‘ Group Reminder

Print Exit

Figure 5-3. Searching accident reports for accidents occurring in one year

Do I have to complete every field on every subtab to search accident reports?

You do not need to complete all the fields on any subtab to search accident reports. In
® T.0.M Tip fact, if you want to view all accident reports in your database, you can leave all the
fields blank and then click the Find Now button.

I completed the screen, but nothing happened. What’s wrong?

If this happens, click Reset. This clears any other criteria you might have selected on the
Employee search screen. Then, select your accident criteria again, and click Find Now.

I don’t know what some of the fields are used for. Where can I find descriptions
for the fields?

Each field on the subtabs is described next in this chapter.
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General Subtab
55 Search Employees Q@
File Security Maintain  Window Help
o M Friday. September 03, 2004
BT T.0.M. Employee Management
(5] Employees} M Reminders] # Training ] ¥ Absences & Accidents \

Accident # Vehicle # =2
Addr/Location: ‘ V¥ Search Entire Accident Type: =
Accident Dt between | jﬁﬂd ‘ j Time between: @ and ﬁ

General [ Detals & Contrbuting Factors | User/Custom |

Date ‘ Time | Type | Location Vehicle |Emp# | Name
Show on Map

Find Now Reset ‘ Group Training | Group Reminder Print | Exit

Figure 5-4. Using the General subtab to search accident reports

You can use the following criteria to search accident reports:

Accident #. Allows you to search employee records using the accident number.

Addr/Location. Allows you to search using an address or a location. You can type a partial
address, but to do so, make sure you check the Search Entire checkbox. If you type pa and click
Find Now without checking Search Entire, the Employee Management system probably will not
return any records unless an employee lives on a street called Pa. However, if you type pa, check
the Search Entire checkbox, and then click Find Now, the Employee Management system returns,
for example, employee records containing street names like Eagle Pass and Patterson Circle.

Search Entire. Allows you to search for a partial address. When this option is not checked, the
Employee Management system searches the address using only the characters you type in.

Acct Dt Between. (Accident Date Between) Allows you to search employee records within a
given range.

»  You can access the calendar by clicking on the pull-down arrow. Then, you can use the
arrows displayed around the month to change the month or the arrows around the year to
change the year. When the calendar displays the correct month and year, select the day. After
you click the day, the Employee Management system closes the calendar and displays the
date.

» You can also type a date into any of these fields, but if you only type the month and year, the
Employee Management system uses the first of the month as the default value.

Vehicle #. Allows you to search all accidents involving a specific vehicle.
Accident type. Allows you to search by the type of accident.
Time Between. Allows you to search employee records within a given time period.

»  You can access the clock by clicking on the clock icon. Then, you can select the hour, the
minute, and whether the time was a.m. or p.m. After you select the time and click OK, the
Employee Management system closes the clock and displays the selected time.
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»  You can also type the time into these fields, but the Employee Management system requires
that you use the format of hh:mm a.m/p.m. For example, to search for accidents occurring at
2:30 in the afternoon, you need to type 2:30 p.m. into the field.

Where do the accident types come from? Can I create new ones, or am I able to
only use the default types?

You can add, edit, and delete accident codes by selecting File>Accident>Accident
Types. You can also select File>Accident to set up contributing factors for accidents,
the reasons the vehicle was in use, injury codes, and damage codes.

Details and Contributing Factors Subtab

85 Search Employees E]@

File Security Maintain Window Help

#F T.0.M. Employee Management .

€ Employees ] Reminders] & Training ] 7 Absences & Accidents l

Contributing Factors In Use For ,—L| MNumber of Passengers Exceeding:
BD_EACK -~ '
EB‘IE)Q%RT: e = Injury: - Used? Preventable? [
BD:HE)";’-.-' " ] Run: I Fire Extinguisher Citation lssued:
- i BD_SIGNAL v o C Yos N
Click this tab Damage: S| || e &= °
to view Details
—==r=® Details & Contributing Factors | |Jser/Custom J
and [T L
Contributing Date | Time | Type | Location Vehicle | Emp# | Name
Factors search
options.
<] (2]
Show on Map

Find Now ‘ Reset | Group Training Group Reminder Print Exit

Figure 5-5. Details and Contributing Factors subtab

You can use the following criteria to search employee records:

e  Contributing Factors. Allows you to search for all accident reports that have the selected
contributing factor(s). You can select more than one contributing factor by holding down either
the CTRL key while clicking on desired additional contributing factors or by holding down the
SHIFT key while clicking on the additional Contributing Factors.

NOTE: If you select more than one Contributing Factor to search on, you are telling the Employee
Management system to find all accident reports that contain ALL of the selected contributing factors.
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e In Use For. Allows you to search for accident reports where the vehicle was in use for a
particular purpose (such as a field trip).

e Injury. Allows you to search for accident reports that resulted in an type of injury, if any.
¢ Run. Allows you to search for accident reports occurring on a particular bus run.
e Damage. Allows you to search for accident reports resulting in damage, if any.

e Number of Passengers Exceeding. Allows you to search for accidents having a specific number
of passengers involved in the accident equal to or exceeding the entered number.

e Preventable? Allows to select all accident reports that were marked as preventable.

e Used Fire Extinguisher, First Aid Kit. Allows you to search for accidents where a fire
extinguisher or first aid kit was used at the site of the accident.

o Citation Issued. Allows you to search for accidents that had or did not have a citation issued.

User/Custom Subtab

In addition to the being able to search accident reports using the General and Details and Contributing
Factors tab, you can also create your own fields to customize the accident information the Employee
Management system tracks for you. You can then use these fields to search for accident reports just as you
select criteria on the other tabs.

NOTE: You can add 7 general fields and 2 date fields to the accident tracking system, and their names,
or captions, can be up to 30 characters in length.

I added custom fields, but I don’t see them.

After you add custom fields, be sure you click OK (and not Exit) on the Employee

® T.0.M Tip Management Options screen. Then click OK to close the District Options screen. You
need to close the Employee Management system and restart it so that your fields are
added to the User/Custom tab. Click the User/Custom tab to view the added fields.

To create customized accident tracking fields:

1. Select File>Other>District Options (Figure 5-6). The Employee Management system displays the
District Options screen.

85 Search Employees

File Security Maintain \Window Help
Check-IN

sbsence Codes I)M Employee Management

Acddent

Reminders

' |l Remimders] & Training] ki Absences] & Accidentsl

Training Codes

Vehides

Other ¥ Employee Types

Shifts Employee Statuses
Ethnicity Codes
Vehide Types

Divigion/Garages
Department/Sections
District Options

Figure 5-6. Selecting File>Other>District Options

2. Click the Employment Management button (Figure 5-7). The Employee Management system displays
the Employee Management Options screen.
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85 T.0.M. District Options

T.0.M. District Options

Organization Name: |

Transportation Title: |

Address #1:
Address #2: Zip:
City / State: | |

Click here to
create custom
employee
record fields.

Phone: Fax:

Email: |

. Employee
GIS Routing Management Conduct

Student Employee

Field Trips [

Payroll WebTrips

OK

Exit

Figure 5-7. District Options screen

3. Click the Accident Custom Fields tab.

4. Type the name of the field into the caption box. To add a general field, type the name into the User 1
Caption field. To add a date field, type the name into the User Date 1 Caption field. Figure 5-8 shows
that a general field with a name, or caption, of Responding officer is being added to the system:

55 Employee Management Options E]@
@ Employee Management Options
Employee Custom Fields ~ Accident Custom Fields IChe:k-In 1
User Defined Fields for Accident Tracking
Type general
field names, P User 1 Caption ‘P\esponding officer User Date 1 Caption: |AcciclemDate1 < Type date field
or captions User Date 2 Caption: |Accident Date2 names here.
h ’ User 2 Caption ‘AccidentUseQ SR L i
ere.

User 3 Caption ‘Accident Userd

User 4 Caption ‘Accident User4

User 5 Caption ‘Accident Users

User 6 Caption ‘Accident Usert

User 7 Caption ‘Accident User?

OK Exit

Figure 5-8. Adding customized accident fields to the system

4. Click the OK button to add your customized fields to the Employee Management system and close the
screen. The Employee Management system displays the District Options screen.
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5. Click the OK button to close the District Options screen.
6. Click Exit to close the Employee Management system.
7. Restart the Employee Management system.

8. Click the Accidents tab.

9. Click the User/Custom tab. The Employee Management system displays the customized fields you
added to the system (Figure 5-9).

85 Search Employees E]@

File Security Maintain Window Help

’ﬁ T.0.M. Employee Management

& Employees ] Reminders] & Training ] % Absences &) Accidents l

Friday, September 03, 2004

Responding  officer: - Accident Userd: h Accident User7: h

Accident UserZ: - : s - : . -
General fields lgent User. Accident Userb: Accident Datel: | J Date ﬁelds
appear here. Accident Userd: v Accident Users: e Accident Date2: ~1| appear here.

]
General ] Details & Contributing Factors  User/Custom
Date | Time | Type | Location Vehicle | Emp # | Name
<] 1 B
Show on Map

Print Exit

Find Now | Reset ‘ Group Training Group Reminder

Figure 5-9. Viewing customized accident fields

To search using customized accident fields:

NOTE: You can only search using customized accident fields if you added them to the Employee
Management system.

1. Click the Accidents tab.
2. Click the Reset button to clear the screen. The Employee Management system clears the screen.
3. Click on the Accidents tab.

4. Click on the User/Custom tab and select search criteria as you would on other screens.
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5. Click the Find Now button to retrieve all the employee records in the database that match your selected
criteria.

Combining the Accident Search Options with Employee
Search Options

You can combine your employee accident reports search with the overall employee search for very
sophisticated search options. For example, you can search for all the accidents all drivers had during the
course of one year.

1. Click the Employees tab.

2. Click the Reset button to clear the screen. The Employee Management system clears the screen.

3. Select employee search criteria.

Figure 5-10 shows Driver being selected as the Employee Type on the Employees tab:

B[=1[%

Tuesday, August 31, 2004

85l Search Em ployees

File Security Maintsin  Window Help

’ﬁ T.0.M. Employee Management

& Employees l@ F{emindersl iy Traininﬂ it Absenoesl ) Accidentsl

Employee ID: SSN: Gender
{ -
Last Name: | Em | Male Female
Address | I Search Entire Ethnicity -

Employee Type: |0 -
A DRIVING Al

General |Usar Deﬁned] Ernp\aymem] Dates | Sorting

A[ND) NON-DRIVING AIDE
Employee#| LastName ‘ First Name | Employee Type | Phone ‘ Addres: 4R e 152D
AlS) SUB AIDE
C CAR DRIVER
COA COACH
o] DRIVER
Show on Map | MNew | Edit | Delete|
Find Now | Reset ‘ Group Training ‘ Group Reminder Print Exit

Figure 5-10. Selecting Driver as the Employee Type

4. Click the Accidents tab. The Employee Management system displays the Accidents tab.

5. Select the accident report search criteria you want to include in the search.

Figure 5-11 shows that the accident date range has been selected as the accident report criteria:

T.0.M. Employee Management Manual
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#L Search Employees g[ﬂjﬁ

File Security Maintain  Window Help

’ﬁ T.0.M. Employee Management T

(=] Emplr:}yeesl B F{emmdersl & Training

T Absences & Accidents |

Accident # Vehicle & e
Addr/Location: | I~ Search Entire Accident Type: &
Accident Dt between: [9/1/2003 | and [g/31/2004 ~] Time between: | @I and | @I

General I Details & Contributing Factors ! User/Custom |

Date I Time l Type i Location Vehicle |Emp# | Name

B m (>

Show on Map
Find Now | Reset | Group Training | Group Reminder | Print Exit

Figure 5-11. Using the Accident Date range fields to search accident reports

6. Click the Find Now button to retrieve all the accident reports in the database that match the accident
report search criteria and that belong to employees who match the Employee search criteria.

ol Search Employees g@
File Security Maintain  Window Help
= -~ Friday, September 10, 2004
BT T.0.M. Employee Management
(o] Employeesl 2] Rem\ndersl &z Training | %, Absences &) Accidents | 3 Record(s) Found
Accident # Vehicle # S
Addr/Location: | [~ Search Entire Accident Type: e
Accident Dt between- [5/1/2003 =] and [3/31/2004 <]  Timebetwesn: | and | B
General I Details & Contributing Factors ! User/Custom |
Date I Time I Type i Location Vehicle |Emp# | Name
9/25/2003 4:.00 PM COLL_VEH 5120 W.MERCER LN. GLENDALE AZ (0042 123 HINDIY
1/8/2004  2:35PM COLL_BIKE 32nd 8T & GREENWAY RD. PHOENL.. 1892 338 SMITH.
511/2004 3:30PM COLL_FO 23 MAIN STREET. CONCORD NH 656 SMITH,
f_l i1} ‘-1‘
Show on Map
Find Now | Reset | Group Training | Group Reminder | Print | Exit |

Figure 5-12. Sample of combining Accidents tab with the Employees tab
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Working with an Individual Employee’s Accident Reports

To add, change, or delete accident reports, you must be working with an individual employee’s record.

1. Click the Employees tab.

2. Click the Reset button to clear the screen. The Employee Management system clears the screen.

3. Select the search criteria.

4. Click the Find Now button to retrieve all the employee records in the database that match your selected
criteria. Figure 5-13 shows Smith as the search criteria:

85l Search Employees g@
File Security Maintsin  Window Help
. Thursday, September 02, 2004
PM T7.0.M. Employee Management
& Employees l@ F{emindersl iy Traininﬂ b Absenoes] o) Accidentsl 6 Record(s) Found
Employee ID: S5N: Gender
- -
Last Name: |:mith First: | Cas [Femzs
Address | I"" Search Entire Ethnicity -
Employee Type -
General |Usar Deﬁned] Ernp\aymem] Dates | Sorting
Employee#| LastName ‘ First Name | Employee Type | Phone ‘ Address ‘
264 SMITH ALVIN DRIVING AIDE 23 Rte 3 North
338 SMITH DONALD DRIVER 8987339087
438 SMITH LATASHA DRIVER
265 SMITH REBECCA DRIVER
636 SMITH STANLEY DRIVER 5151234567 127ELM STREET
339 SMITH WANESSA DRIVER 5609 N BIRCH AVE \
N
Show on Map | New | Edit Delete |

Find Now | Reset ‘

Group Training ‘ Group Reminder Print Exit

Select the
employee
record you
want to edit,
and click Edit.
You can also
double-click
the record.

5. Either:

Figure 5-13. Search results of Smith

e Double-click the employee’s record.

OR

e Select the employee record, and click Edit.

6. Click the Accidents tab. The Employee Management system displays the employee’s accidents

(Figure 5-14).

T.0.M. Employee Management Manual
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g Employee Maintenance - g@

Employee

Genaralw Employment & License] REminders} Hotes Accidents IAbsences Training | User Defined

SMITH. STANLEY ID#686

Accidents
Displays the Date Time Type Lacation Vehicle
employee’s /5112004 330PM COLL_FO 23 MAIN STREET
accident
reports.

Add | Edit ‘ Delete

Routes Exit

Figure 5-14. Viewing an employee’s accidents

Adding Accidents

In this section, you will learn how to add an accident record to the system. You will find a description for
each field on the Employee Accidents screen after the procedure below.

Adding Accident Records

1. Click the Add button on the Accidents screen. The Employee Management system displays the
Accident/Incident screen.
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5 Employee Maintenance -

/oS

Click Add to
add an
accident
record.

Employee

SMITH. STANLEY 1D#686

Generall Employment & L\censel Reminders | Notes Accidents |Absences Training | User Defined

Accidents:
Cate | Time | Type | Location |Vehic|e |
5/11/2004 330PM COLL_FO 23 MAIN STREET
—

\ add | Eat | Delete

Roves_|

Exit |

Figure 5-15. Adding accident records

2. Select or type in the information you want to save with the accident report.

A sample accident record looks like:

‘Accident / Incident

Accident / Incident

— General
Accident #: i12398?5 I : 'I
Vehicle# (0044 SMITH, STANLEY
Accident Date: |9,‘T 0/2004 - | Friday Time: [3:47 pm\ ,@;l
AddrfLocation: |128 Loudon Rd
Concord mH [45367
—Centributing Factors
Potential Applicable
Code I Descrigi__“_} = Code Diescription
BD_BACK BUS DF— Ll
BO_LOC BUSDFlsw|
£ - ) SRemove | oy ) @

Could driver have prevented accidentfincident by driving defensively? I
Comments/Description:

Driver Recommendations:

Details lCrtaﬁDn lssued | User/Custom Fields f@—

InUseFor. |FIELDTRIP ¥

You can add
more accident
details using
these tabs.

Run: l—
Number of Passengers: m
Type: iW;]
Injury: m

Damage: |LESS s
Used?

I~ Fire Extinguisher

I First Aid Kit

The other driver ran a stop sign and damaged
the right front fender of the bus.

MNone

Show on Map |

Exit

Figure 5-16. Sample accident record
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3. Click the OK button to save your changes and close the screen. The Employment Management system

update the employee’s accident record:

Accident/Incident Screen

You can add the following accident information to the system:

Accident / Incident

Accident / Incident

~General

Accident# |1233376 =

Vehicle# |0044 v] SMITH. STANLEY

Accident Date:  |9/10/2004 v | Friday Time: [3:47 pm| @j

AddrfLocation: |128 Loudon Rd

Concord NH [45367

Contributing Facters

Potential Applicable
Code | Descripf*l FRrEL Code | Deescription
BD_BACK BUS DF— Sitecks

BD_LOC BUS DF-V_‘ =
S B | _<Remove | [ey—— B

Could driver have prevented accidentfincident by driving defensively? [
Comments/Description:

Driver Recommendations:

Details ]Crtation lssued ] User/Custom Fields |

InUse For. |FIELDTRIP i
Run:
Number of Passengers: |0 EC

Type: |COLL_VEH -

Injury: |NONE i
Damage: |LESS i
Used? 1

I~ Fire Extinguisher
I First Aid Kit

You can add
more accident
details using
these tabs.

The other driver ran a stop sign and damaged MNone
the rightfront fender ofthe bus.

Exit

Figure 5-17. Accident/Incident screen

e Accident #. Allows you to type the accident number. You can type up 20 alphanumeric

characters, meaning you can type numbers or letters into this field.

e Employee. Displays the employee’s identification number and name. You cannot edit these fields.

e Vehicle #. Allows you to select the vehicle number from a list of vehicles that you have already

entered into the Employee Management database of the vehicle that was involved in the

accident/incident.

e Accident Date. Allows you to type the date of the accident. After you select or type the date, the
Employee Management system displays the day of week for the selected date.

»  You can access the calendar by clicking on the pull-down arrow. Then, you can use the
arrows displayed around the month to change the month or the arrows around the year to

change the year. When the calendar displays the correct month and year, select the day. After
you click the day, the Employee Management system closes the calendar and displays the

date.

» You can also type a date into any of these fields, but if you only type the month and year, the
Employee Management system uses the first of the month as the default value.

5-14
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e Time. Allows you to enter the time the accident occurred. If you do not add the time, the
Employee Management system uses 12:00 a.m. as the default value.

»  You can access the clock by clicking on the clock icon. Then, you can select the hour, the
minute, and whether the time was a.m. or p.m. After you select the time and click OK, the
Employee Management system closes the clock and displays the selected time.

»  You can also type the time into these fields, but the Employee Management system requires
that you use the format of h:mm a.m/p.m. For example, to search for accidents occurring at
2:30 in the afternoon, you need to type 2:30 p.m. into the field.

e Addr/Location. Allows you to type the address or a location where the accident occurred. You
can add information to two address lines, each of which allows you to type in 100 alphanumeric
characters. Additionally, you can enter up to 20 characters for the city, 2 characters for the state,
and up to 10 for the zip code.

e  Contributing Factors. Allows you to select the factors that contributed to the accident. Potential
Causes lists all the contributing factors that have been added to the Employee Management
system. To add a contributing factor to the accident, select it, and click Add. You can add more
than once contributing factor by holding down your Ctrl or Shift key while you click on the names
of the contributing factors.

e Could driver have prevented accident/incident by driving defensively? Allows you to specify
whether the accident could have been prevented by defensive driving.

e Comments/Description. Allows you to add comments to the accident report. If the comments
have to do with citations issued for this accident, you can add those comments to the Comment
box on the Citations tab. You can type an unlimited number of characters into this box.

e Driver Recommendations. Allows you to add any recommendations that were made to the
driver. You can type an unlimited number of characters into this box.

o Details subtab ( a\ ure C — | ‘g

» In Use For. Allowsyou to select from a user defined list of In Use For codes that you can
maintain in the employee management software for accident reports.

»  Run. Allows you to enter the bus run or route number. You can enter up to 20 alphanumeric
characters into this field.

» Number of Passengers. Allows you to enter the number of passengers involved in the
accident.

» Type. Allows you to select the type of accident from a predefined list of Accident Types that
you maintain in the software.

» Injury. Allows you to select the type of injury, if any, that resulted from the accident from a
predefined list of Injury Types that you can maintain in the software.

» Damage. Allows you to select how much damage resulted from the accident, if any, from a
predefined list of Damage codes that you can maintain in the software.

» Used Fire Extinguisher/First Aid Kit. Allows you to specify whether a fire extinguisher or
first aid kit was used at the site of the accident.

e Citation Issued subtab. Allows you to specify whether a citation was issued. You can also add
comments (Figure 5-18).
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Accident / Incident

Accident / Incident

General

Details ser/Custom Fields
Accident # 1239876
Q Citation |ssued:
Vehicle # 0044 v SMITH. STANLEY ~ Yes & No
Accident Date:  |9/10/2004 ~| Friday Time: ﬁ Comments: N Click here to
e 5 witnesses at the scene and two : :

Addr/Location: |128 Loudon Rd apecanos on foe be aoret 1 add citation
'wasnt his fault, and the other driver information
was cited :

Concord NH 45367
Contributing Factors
Potential Applicable

Code ‘ Descripi | Add > Code ‘ Description
BL_BACK BUsDF— 2907

BD_LOC BUS DFja | )

<] . E3 & REuLE <] 1l (2]

Could driver have prevented accidentfincident by driving defensively? r

Comments/Description: Driver Recommendations:

The other driver ran a stop sign and damaged MNaone
the right front fender of the bus.

Show on Map Exit

Figure 5-18. Citations tab

User/Custom Fields tab. If you added customized accident tracking fields to the Employee

Management system, you can enter information into those fields on this tab> To t¢arn about adding \ O\
customized accident tracking fields to the system, see the User/Custom Subtab section found éd
previously in this chapter. ( P'\ uj) (R

You can also add attachments to the accident. For example, suppose that the accident report had
photos with it; you can add those photos to the Employee Management system.

Figure 5-19 shows that an attachment has been added to the accident report:
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Accident / Incident

Accident / Incident

~General

Details ] Citation Issued  User/Custom Fitﬂd#

Accident # [1239876 Employe : Click here
Accident U to add
Vehicle# [1044 =] SMITH. STANLEY AccidentU| information
Accident Date:  |9/10/2004 v] Friday Time: |3:47 PM _@J Accident U to the
Accident U
AddrfLocation. |128 Loudon Rd i user/custom
Accident U fields or to
Accident U
Concord NH 45367 e add
: Accident U attachments
Contributing Factors . jﬁ to the
Potertial Applicable S - accident
= = Accident D -
Code = ‘ DBSC”FdiA.; Add> Code ‘ Description report.
BD_BACK BUS DF— Attachments |
BD_LOC BUS DFjae| [CAD: nents
= ) < Remove = ) % Browse Clear
] ] e
Could driver have prevented accident/incident by driving defensively? [ Browse | Clear
Comments/Description: Driver Recommendations:
[The other driver ran 2 stop sign and damaged [None

the right front fender of the bus.

OK Show on Map Exit

Figure 5-19. User/Custom subtab

Adding Attachments to Accident Reports
What are attachments?

Many times it is helpful to include with the accident report an attached document that gives the user more
information about this accident report (for example, photographs or the original scanned accident report or
citation). The T.O.M. Employee Management software has the capability.

Attachments are nothing more than links or pointers to another document on the computer that is
considered relevant to the accident report. By allowing you to “attach” these documents to an accident
report, the T.O.M. Employee Management software makes it easy for you to quickly open one of these
associated documents while viewing the accident report.

Warning notes about attachments:
Because attachments are nothing more than links to document files you must be aware of two points:

1. Make sure that the actual document file is in a location that all Employee Management users that will
work with accident reports can access the file. If you add an attachment to a document that is on your
personal computer and another user tries to open that link but doesn’t have access to that file, that user
will receive an error message.

2. Ifyou attach a document file to an accident report that requires a special program to open (such as an
Adobe Photoshop) that a user does not have, that user will receive an error if he tries to open that
attached file from his computer.
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To add an attachment to an accident report:

1. Either:

e  Select the accident report you want to edit, and click the Edit button.

OR

e Double-click the employee’s accident report.

The Employee Management system displays the Accident/Incident screen.

2. Click the User/Custom Fields tab.

2. Click the Browse button (Figure 5-20).

vAcci dent / Incident

Accident / Incident

— General

Accident # i12398?5 Employes

Addr/Location: |128 Loudon Rd

Vehicle# |0044 ~ SMITH. STANLEY

Accident Date: IQI‘I 0/2004 'i Friday Time: !3:4? PM @l

Concord NH [45367
—Contributing Factors
Potential Applicable
Code | Desc:n'_p1i4\] Add > | Code | Description
BD_BACK BUS DF—! _
BD_LOC BUS DFw|
i) (SR § 7y @

Could driver have prevented accident/incident by driving defensively? [

Comments/Description: Driver Recommendations:

Details l Citation lssued User/Custom FiEh:lS‘h

Accident Ul
Accident Ul

Accident U|

AccidentU|
AccidentU|
AccidentU|
AccidentU|

Accident DI
Accident D %

’Ii Browse/ ’a

| Browse | Clear

| 4

| Browse | Clear

Click the
User/Custom
Fields tab.

Then, click
Browse to
navigate to the
file you want
to attach to the
reminder.

The other driver ran a stop sign and damaged
the right front fender of the bus.

MNaone

oK | Show on Map |

Exit |

Figure 5-20. Adding an attachment to an accident report

4. Navigate to where the document is stored, select it, and click Open.
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Figure 5-21. Selecting an attachment

Open
Look in: I@ Documents _'J = Iﬂ‘ Ef-
3 | BusAccident
l_\.é‘- '@drlwngtest
Iy Recent
Documents
=
E
Deskion i Select the
:, attachment,
7} and click
My Documents Open_
My Computer
My Networke  File name: IBusAccident LI Open ! I
Flaces
Files of type: I Ll Cancel I
|

The Employee Management system adds the attachment to the accident report. You can add up to

three attachments to the accident report (Figure 5-22).

‘Accident / Incident

Accident / Incident

—General
Dietails I Citation lesued  User/Custom Fields

Accident # 1239876 Emy I "i
Accident U

Vehicle# (0044 = SMITH, STANLEY O
Accident Date: | 5/10/2004 v! Friday Time: !3:4? PM A@;J Accident U
Addr/Location: |128 Loudon Rd ARALEIL
Accident U
Concerd [N 45367 ACckentt
i Accident U

 Contributing Faclors Fore i—
Potential Applicable LLEL] b
Code Dascrig::\_] Add> Code Dlescription pceeotl P
BD_BACK BUS DF— Q‘ Aitack
BO_LOC BUS DF{w| CliDocuments |
i B <Remove | [y B) | | Busccigen | See] Cle
= - = = Browse Clear
Could driver have prevented accidentfincident by driving defensively? [ | Browse | Clear
Comments/Description: Driver Recommendations:
The other driver ran a stop sign and damaged Maone

the right front fender of the bus.

oK | Show on Map | Exit |

An attachment
has been added
to the accident
report.

Figure 5-22. Adding an attachment to an accident report

5. Click the OK button to save the accident report. The Employee Management system adds the

attachment to the accident report.
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Viewing and Clearing Attachments

To view attachments, follow these steps:

1. Either:
e  Select the accident report you want to edit, and click the Edit button.
OR
e Double-click the employee’s accident report.
The Employee Management system displays the Accident/Incident screen.
2. Click on the attachment you want to view (Figure 5-23).
Accident / Incident
Accident / Incident
Click on the
General Dietails ] Citation lesued  User/Custom Fields [ a'.:taCh.ment to
Accident # 1239876 : = v View i1t.
Accidentt|
Vehicle & 0044 vl SMITH. STANLEY Accidentuj—- Remember
Accident Date: |9/10/2004 v] Friday Time: [3:47 PM @j AccidentU you need t(;
AddrfLocation: [128 Loudon Rd Aciaty have the
Accfde"t Y appropriate
Cancord 45367 Aciaty software to
Accilentt) open files. For
Contributing Factors X P
—— Applcable AccidentD example, this is
Code ‘ Dascn’_p154\ ‘ Description pceeotl aBMP ﬁle’
BD_BACK BUSDF—) __Add> Attachments — which is a
E[;_LOC BUS&'E?W e | 5] % Browse | Clear common
|= L1} =) Browse Clex graphlc fOl‘mat.
Could driver have prevented accidentfincident by driving defensively? [ Browse | Clear You should be
Comments/Description: Driver Recommendations: ab'le to view )
[The other driverran 2 stop sign and damaged [None this file typ.e m
the right front fender of the bus. most graphlc
programs.
oK Show on Map Exit
Figure 5-23. Viewing an attachment
The attachment in Figure 5-23 is a BMP file, which is a common graphic format. Most graphics
program (including Microsoft Paint if it was installed as part of your Windows installation). Notice
how the BMP files is viewed in Microsoft Paint (Figure 2-24) and not within the Employee
Management system. Because attachments are viewed outside the Employee Management system, you
need to have the software required by the file type. If you do not have the appropriate program to U
open the attachment, you will not be able to view it. /O\t\
Also notice that the file has been added from the c: drive. Only those who have access to the c: drive
will be able to access the file.
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"1 BusAccident - Paint M=)

File Edit View Image Colors Help

(o VT 5 O O o
S CEECECERC R EEE

For Help, dick Help Topics on the Help Menu,

Figure 2-24. Viewing a BMP file in Microsoft Paint
To clear attachments:
1. Either:

e Select the accident report you want to edit, and click the Edit button.

OR
e Double-click the accident report.

The Employee Management system displays the Accident/Incident screen.

2. Click the Clear button to remove the attachment from the accident report.
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Accident / Incident

Accident / Incident

—General
Accident # |1235876 E = -
Vehicle & |0044 v; SMITH, STANLEY
Accident Date:  |9/10/2004 '; Friday Time: ]3:47 P _@j
AddrfLocation. |128 Loudon Rd
Concord MNH 45367

—Contributing Factors

Potential Applicable

Code J Dascn’pﬂ'_\_J = Code J Description

BD_BACK bus ot | Add> |

BD_LOC BUSDFw]

[l ) | SRemove | ey ] @

Could driver have prevented accident/incident by driving defensively? [

Comments/Description: Driver Recommendations:

Details i Citation lssued  User/Custom Fislds

Accidentt|
Accidentt|
Accidentt|
Accidentt|
Accidentt|
Accidentt|
AccidentU[

Accident D

Accident D =

Clear

Clear

Clear

oK

[The other driver ran 2 stop sign and damaged
the right front fender of the bus.

MNone

Show on Map

Exit

Click Clear to
remove the
attachment
from the
accident
report.

Figure 2-25. Clearing an attachment

3. Click the OK button to save your changes and close the screen.

Editing Accidents

Editing an employee’s accident reports is very similar to editing his employee record information.

To edit employee accident reports:

1. Select the accident record you want to update, and click Edit (Figure 5-26). You can also double-click
the record. The Employee Management system displays the Accident/Incident screen.
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55 Employee Maintenance -

SEX

Select the
accident
record, and
click Edit.

You can also
double-click
the record.

Employee

SMITH. STANLEY ID#686

General] Employment & License1 Reminders] Notes Accidents ]Absences Training | User Deﬂnedl

Accidents:
Date ] Time | Type Location Wehicle
5/11/2004 330 PM COLL_FO 23 MAIN STREET
— |
Add Edit ‘ Delete

Routes

Exit

Figure 5-26. Editing employee accidents

2. Update the employee’ accident record.

3. Click OK to save your changes. The Employee Management system closes the screen and updates the

employee’s accident record.

Generating and Printing Accident Reports

You can generate and print several types of accident reports for an employee or a group of employees by
clicking the Print button. When you click the Print button, the Employee Management system displays a
dialog that allows you to select the type of accident report you want to generate and to type in its title.

T.0.M. Employee Management Manual

5-23



Chapter 5: Working with Employee Accident Records

85! Search Employees E]@

File Security Maintain  Window Help

’ﬁ T.0.M. Employee Management

€& Employees ] Reminders] & Training ] 7 Absences & Accidents ] 6 Record(s) Found

Friday, September 03, 2004

Accident Userl: B Accident Userd: x Accident User7: X
Accident User2: T Accident Userb: 54 Accident Datel: &4
Accident User3: T Accident Userb: 54 Accident Date2: &4

General | Details & Contributing Factors  User/Custom

Date | Time | Type I Location Vehicle | Emp # | MName
5/25/2003 5:45AM COLL_OTHER 1516 E BELL RD, PHOENIX AZ 6003 153 KIUSLIN
8/5/2003 3:50PM COLL_BIKE 1901 W BELL RD, PHOENIX AZ 3005 145 JEHNS
9/25/2003 4:00 PM COLL_VEH 5120 W. MERCER LN, GLENDALE AZ 0042 123 HINDIY
1/8/2004 2:35PM COLL_BIKE 32nd ST & GREENWAY RD, PHOENI... 1892 333 SMITH,
5/11/2004 3:30PM COLL_FO 23 MAIN STREET, CONCORD NH 656 SMITH,
9/1/2004  12:00 AM } 7044 533 SCHRE Click the Print
button to
: . generate and
£l i > Pz .
] ] print an
Show on Map accident report.

Find Now | Reset ‘ Group Training Group Reminder Print ( Exit ‘

NOTE: For more information about generating and printing accident reports, see Chapter 13 of the
Users section.

Viewing Accident Reports on a Map using Microsoft MapPoint

Viewing your accident reports on a map can be a very useful feature especially if you want to identify areas
that are potentially dangerous driving areas. To use this feature, you are required to have Microsoft
MapPoint 2002 (or newer) installed on the workstation you use to operate the Employee Management
system. The Employee Management system contains links to MapPoint that allow you to click once to use
the mapping feature that gives you the ability to generate a map for a single employee or a group of
employees.

I generated a map for accident reports, but I don’t understand how to manipulate
it.

® T.0.M Tip Refer to your documentation for Microsoft MapPoint for information about how to use
this product.

Creating and Viewing a Map of a Single Accident Report
1. To access the Accident/Incident screen:

e  Sclect the accident record, and click Edit.
OR
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e  Double-click the accident record.

e Employee Maintenance -

Jokd

2 Employee

3

SMITH. STANLEY ID#686

Generall Employment&LicenseI Remmdersl Notes Accidents IAbsences Training | User Defined

Accidents:
Date I Time I Type | Location |Veh\c|e |
Select the 5/11/2004 330PM COLL_FO 23 MAIN STREET _
9/10/2004 o  347PM COLL_VEH 128 Loudon Rd 0044
accident record
you want to
view on the
map, and click
Edit. You can
also double-
click the
record.
Add Edit | Delete
Routes Exit

Figure 5-27. Selecting the accident record you want to view on a map

3. Click the Show on Map button (Figure 5-28).

‘Accident / Incident

Accident / Incident

—General
Dietails User/Custom Fields
Accident # |1239876 I ¥ "; o
Citation |ssued:
Vehicle & 0044 hd SMITH. STANLEY " Yes = No
Accident Date:  |9/10/2004 '! Friday Time: | A@J Comments:
Addr/Location: |128 Loudon Rd 5 witnesses at the scene and two
: chaperones on the bus agreed it
wasnt his fault. and the other driver
was cited
Concard NH 45367
Click Show on
— Contributing Factors
Potential Applicable Map to
— = — — | generate and
= EECI‘IE l___‘ = i eSCnpLion LA .
BO_BACK BUS DF— M VIEW a map for
BD_LOC BUS DFfs| ; :
B 5 L <Remove | [ B this accident
) b | (= ) el | = record.
Could driver have prevented accidentfincident by driving defensively? [
Comments/Description: Driver Recommendations:
The other driver ran a stop sign and damaged Maone
the right front fender of the bus.
Show on Map Exit |
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Figure 5-28. Generating a map showing an employee's address

Microsoft MapPoint launches and displays the map (Figure 5-29).

& Map - Microsoft MapPoint 2004 North America Trial

/o

File Edit View Data Route Tools Help

DEE SN -~ EfAf@adai B S@a 8m b
Lo |123 Loudon Rd, Concord, NH 03301 VIFind =

United States ~ New Hampshire ~ Concord Heights

viston 0

Legend and Overview 5'

'ortsmouth

s Rockport = i}
=

B Pushpins
& My Pushpins
Populated Places
Boundaries
Transportation
Parks and Reserves
Points of Interest
National Park Facilities

128 Loudon Rd
Concord, MH 03301

Miscellaneous

= o
AR
s
a2

!
3
ey

"'g

]
o
=]

128 Loudon Rd, Concord, ... X

P |

- 8- 4 N NG OOGE &- 8-

L=
=0

Figure 5-29. Sample map of a single accident report

Creating and Viewing a Map of a Group of Accident Reports

You can also create and view a map for a group of accident reports. This feature is very powerful in that it

can help you identify potentially dangerous driving areas in your school district.
To view a map of a group of employees address:

1. Search for the group of accidents that you want to view on a map.

Figure 5-30 shows searching for all accident reports containing the words bell rd. Notice that Search
Entire has been selected so that all addresses containing the words bell rd are returned from the

database.
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a Search Employees

M(=1]

File Security Maintain ‘Window Help

W T.0.M. Employee Management

Friday, September 10, 2004

Accident # I

AddrLocation: |bell rd

W Search Entireqg- Accident Type: 'I

2 Record(s) Found

Vehicle #: 'I |

Bell Rd has been

Accident Dt between: | | and | - Time o I & entered as the
address, and
Search Entire was
General I Details & Contributing Factors I User/Custom I selected.

FiI‘St, click Date | Time | Type | Location Vehicle Emp# | Name

Find Now to 5/25/2003 545 AM COLL_OTHER 1516 EBELL RD, PHOENIX AZ 6003 159 KUSLIN

retrieve 8/5/2003  3:50 PM COLL_BIKE 1901 W BELL RD, PHOENIX AZ 3005 145 JEHNS

records.

Then, click

Show on

Map to N\ 3 i . R]

generate the

mapped Show on Map |

shown in the 2]

next graphic. Find Now Reset | Group Training Group Reminder | Print Exit

Figure 5-30. Retrieving a group of records

2. Click Show on Map. Microsoft MapPoint launches and displays the map (Figure 5-31).

‘81 Map - 2 of 2 Records Found.

Fle Edit ¥iew Data Route Tools Help

NEH S0 B oo SR mLE T0a
e rre—

North America  United Statas Phoenix

o= |Tvpe place or address

=

Legend and Overview Arizona

oty 3 ‘.-'%
.%‘ Paaﬂt:Ocean‘Lt %
E Pushpins

B Accidents

Populated Places
Boundaries
Transportation

Parks and Reserves

Paradise
Race
Course

Points of Interest
National Park Facilities

Miscellaneous

Lookout
Mountain
Preserve

Figure 5-31. Sample map of group of accident reports
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Deleting Accidents

When you delete an accident from an employee’s record, the Employee Management system removes it
from the system, meaning that you will not be able to view the accident information again.

To delete an accident from an employee’s record:

1. Access the employee record having the accident record associated with it. The Employee Management

system displays the Employee screen.

2. Click the Accidents screen. The Employee Management system displays the employee’s accident

record.

3. Select the accident you want to delete (Figure 5-32). The Employee Management system asks if you

are sure you want to delete the record.

55 Employee Maintenance -

SET)

Employee

SMITH. STANLEY ID#686

General] Employment & License1 Reminders] Notes Accidents ]Absences Training | User Deﬂned]

Add ‘ Edit ‘ Delete

Accidents:
Date J Time | Type | Location WVehicle
5/11/2004 330 PM COLL_FO 23MAIN STREET

Select the
record you
want to
remove, and
click Delete.

Roues

Exit

Figure 5-32. Deleting an accident from an employee record

4. Click OK to delete the accident. The Employee Management system deletes the accident from the

employee’s record.
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